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Spreadsheet modeling tool helps analyze
power- and ground-plane voltage drops to
keep core voltages within tolerance

Introduction
The trend toward smaller geometries in processor cores
drives requirements for lower-voltage power supplies. For
example, DSPs from Texas Instruments (TI) such as the
TMS320TCI648x series require a 1-V core. As processor-core
voltages drop, clock frequencies are typically increased to
match the thermal capabilities of the packaging and of the
overall cooling systems. That means higher currents in the
power structures of printed circuit boards (PCBs). It is not
uncommon to see 50- to 100-A current requirements for a
1-V rail when multiple processors are distributed on a single
PCB. This article addresses the impact of these higher cur-
rents on the power- and ground-plane design and on the
core-voltage-tolerance budget and describes a spreadsheet
model that may be used to calculate voltage gradients.

Requirements for processor-core voltage
The typical voltage-tolerance budget for the processor core
is 3% for a 1-V rail, which equates to 30 mV for the total
static and dynamic response of the power supply. TI’s new
power devices such as the PTH TurboTrans™ series (T2)
modules, and new synchronous buck controllers such as
the TPS40140, have been designed with internal refer-
ences that allow for 1.5% tolerance under static line, load,
and temperature conditions. The current guidance
allocates the remaining 1.5% tolerance for the transient
response of the supply. This, in combination with the
bandwidth of the switching power supply, determines the
amount of capacitance required to meet the core-voltage
requirements. Local bypassing counteracts the inductive
nature of large ground planes. Little attention is typically
paid to the DC voltage drop in the power planes. As
currents continue to increase and core voltages decrease,
power- and ground-plane DC voltage drops will become a
more significant portion of the total tolerance budget.

Power- and ground-plane voltage-drop
considerations
Power- and ground-plane copper thickness is the primary
attribute that impacts the voltage drop. Another major 
factor is the placement of the processor loads relative to
the power-supply output pins. Power converters such as
the PTH series allow for remote sensing to mitigate board
voltage drops, but there are few tools to aid the designer
in the placement of these remote sensing lines. Most
designers use an ohms-per-square figure for different 

copper thicknesses to calculate an equivalent resistance
and to determine the required copper weight. This tech-
nique works well for simple configurations; but when
multiple processors or significant plane discontinuities are
present (due to vias or other features), the simple ohms-
per-square method may not be adequate to model the
voltage drop in the power and ground planes.

Commercial software
Commercial software for finite-element analysis may be
used to compute the plane voltage drops for arbitrary
geometries, but the software is expensive and requires a
developed expertise. There is no simple tool to generate a
PCB model and quickly assess the plane voltage drops.

SPICE modeling
A model of the PCB may be constructed with an equiva-
lent sheet resistance model (see Figure 1), with sources
and loads connected to the appropriate nodes. The PCB
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Figure 1. Resistor sheet
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model can then be solved with a SPICE-based simulator.
The difficulty in the SPICE method is that the schematic
is unwieldy and the results are difficult to visualize.

A spreadsheet-based model
This article details a method that uses Microsoft® Excel®

spreadsheet software to determine plane voltage distribu-
tion on a PCB with arbitrary geometry and source/load
placement. A little-used feature of Excel, circular refer-
ences and iteration, is used to solve the network matrix.
The method may also be used with other mathematical
software. This article also develops the necessary equa-
tions and provides step-by-step instructions to calculate
power/ground-plane voltage drop for arbitrary source and
load conditions.

Node equations for sheet resistance
Figure 1 is a schematic model of PCB node voltages inter-
connected by equivalent sheet resistances, R, with nodes
expressed as row, column. This model divides the PCB
into 25 nodes. Increasing the number of squares will pro-
vide more resolution. This array is sufficient to illustrate
the general node equations applicable to larger models.
The voltage at any node is determined by using Kirkoff’s
current law, which states that the sum of all currents into
a node must equal zero. One of three equations is required
to determine node voltage, which depends on the node
location—central, edge, or corner.

Central-node equations
For central node 3,3 in Figure 1, the current equation is

(1)

Using Ohm’s law yields

(2)

Solving Equation 2 for V3,3 yields

(3)

Equation 3 is the general form of the equation for a 
central node with arbitrary sheet resistance. This equation
accommodates variations in square resistance that are due
to localized heating or other nonuniformities. In the case
of uniform sheet resistance, Equation 3 simplifies to
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Using Ohm’s law yields

(6)

Solving for V3,1 yields

(7)

Equation 7 is the general form of the equation for an edge
node with arbitrary sheet resistance. In the case of uniform
sheet resistance, Equation 7 simplifies to

(8)

Corner-node equations
For corner node 5,1, Figure 3 depicts the currents flowing
from the two adjacent nodes. The current equation for a
corner node is

(9)I IA B+ = 0.
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Figure 3. Corner node

Edge-node equations
For edge node 3,1, Figure 2 depicts the currents flowing
from the three adjacent nodes. The current equation for
an edge node is

(5)I I IA B C+ + = 0.
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Using Ohm’s law yields

(10)

Solving for V5,1 yields

(11)

Equation 11 is the general form of the equation for a corner
node with arbitrary sheet resistance. In the case of uniform
sheet resistance, Equation 11 simplifies to

(12)

Source nodes
The outputs of power supplies are modeled as fixed values
(voltages) at the geometrically relevant nodes. Many power
supplies utilize differential remote sensing. In the model,
the fixed-voltage nodes may represent the local sense
points, and the power-supply output is varied to set the
desired voltage at those remote sensing points.

The remaining equations solve for node voltages where
a load is present at the node.

Load equations
Central-node equations
In the case of a central node with a load (Figure 4), the
current equation is
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Equation 15 is the general form of the equation for a 
central node with arbitrary sheet resistance and a load
current. In the case of uniform sheet resistance, Equation
15 simplifies to

(16)

Edge-node equations
For the case where load current is sourced from an edge
node (node 3,1 in Figure 2), the node voltage equation is

(17)

For uniform sheet resistance, Equation 17 simplifies to

(18)

Corner-node equations
For the case where load current is sourced from a corner
node (node 5,1 in Figure 3), the node voltage equation is

(19)

For uniform sheet resistance, Equation 19 simplifies to

(20)

The previous equations may be used to model the
power- or ground-plane voltage map of a PCB with 
arbitrary source, resistance, and load arrangements.

Example problem
PCB voltage-drop modeling presents two challenges. The
first is to build the representative model with a number of
voltage sources, path resistances, and loads distributed
across the PCB; the second is to solve the simultaneous
equations. Excel spreadsheet software provides a conve-
nient means to quickly build a model and solve the nodal
equations. Following is a simple example that illustrates
this. A PCB power plane with uniform sheet resistance is
modeled and the voltage at every node is calculated for a
given set of load conditions.

For this example, a 10 × 15-cm copper board with a 1-V/
1-oz power plane and a 1-oz ground return plane is assumed.
A single power supply with 1 output pin provides the volt-
age source, and distributed across the PCB are 10 loads
drawing 5 A each. The goal is to determine the steady-
state voltage at each load with a 65°C board temperature.
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Figure 4. Central load node

Using Ohm’s law yields

(14)

Solving Equation 14 for V3,3 yields
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Worksheet model construction step-by-step
To model the PCB, a worksheet is used where a range of
cells is assigned to represent the node voltages on the PCB.
Each cell corresponds to a square of copper on the PCB.
The size of each square is chosen for a desired geometric
resolution. For instance, if 1-mm geometries (such as slots
or via holes) are desired, then 100 × 150 squares (cells)
would be required to model a 10 × 15-cm PCB. For this
simple example, 5-mm squares are selected to model a 
10 × 7.5-cm PCB, so an array of 20 × 15 cells is used in the
spreadsheet (see Figure 5). The
300 cells are highlighted green
to identify the PCB outline.

Circular references
To build this model, a few non-
intuitive steps must be followed,
because circular references are
required to solve the nodal
equations. “Circular reference”
refers to the condition where
the value of a cell is a function
of its own value in some way.
This situation may be resolved
by allowing Excel to iterate the
value in the cell (by increasing
or decreasing the value) until
some tolerance level is met and
the interrelated equations con-
verge. There are instances when
Excel will not be able to resolve
circular references—particularly
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Figure 5. Model of 10 x 7.5-cm PCB with 5-mm squares

evident when the model is being built or is undergoing
major changes. For this reason, manual calculation is used
in the spreadsheet model.

Initialization
To build the model, it is first assumed that the voltage dis-
tribution is ideal; that is, there is 1 V in every cell. A “1” is
entered in each cell to start (see Figure 6). Note that it is
convenient to label the boundaries of the PCB model with
an index grid to aid in placing the sources and loads.

Figure 6. Model of ideal voltage distribution

Simple model is 15 cells (columns) by 20 cells (rows).  
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The next step is to disable automatic calculation by
checking the Manual “radio button” in the Tools >
Options > Calculation menu (Figure 7). When a change
is made, the F9 key recalculates the worksheet. While this
menu is open, the Iteration box should be checked, and the
parameters Maximum Iterations and Maximum Change

should be set to 20000 and 0.000001, respectively. This
sets the parameters for the solution engine so that iterations
occur up to 20,000 times or until the solution converges to
within 1 µV. These preliminary settings are required to
enable iterative calculations and to avoid convergence
errors while the PCB model is being built and modified.

A simplifying assumption
For this example, the sheet resistance is assumed to be
uniform in the power and ground planes so that a simplify-
ing assumption can be made. The ground- and power-
plane resistances are combined, and the “return” path is
assumed to have zero resistance. That assumption makes
the voltage at each cell representative of the differential
voltage (plane to ground) at every location on the PCB.
The resistance of the power plane is simply doubled to
account for the return path.

Copper-sheet resistance
The sheet resistance of copper is given as

(21)

where ρ is the sheet resistance of copper in ohms per square
ρ20 is the resistivity of copper at 20°C equal to

17.241 mΩ/µm†; α is the temperature coefficient of 
resistance for copper equal to 0.393%/°C†; T is the PCB

( / );Ω �

ρ
ρ α

=
+ −( )⎡⎣ ⎤⎦20 1 20T

h
,

†CRC Handbook of Chemistry and Physics, 58th edition (CRC Press, Inc.,
1977), Section E-84.

Figure 7. PCB model settings entered in Calculation menu 

Figure 8. Implementation of Equation 21 in Excel

temperature in degrees Celsius at the square of interest;
and h is the thickness of the copper plane in micrometers
(1 oz ~ 35.6 µm ±10%). Equation 21 is implemented with
the following Excel equation inserted into cell E2 (see
Figure 8):

=(0.017241*(1+0.00393*($D$8-20)))
/(17.8*(IF($B$3,1,IF($B$4,2,IF($B$5,4,IF($B$6,6,0))))))

The temperature is located in cell D8, and one of the
copper thicknesses in cells B3 through B6 (½, 1, 2, or 3 oz)
is exclusively selected with a “TRUE.” The resulting sheet
resistance value in ohms per square is in cell E2. The value
for twice this resistance (accounting for the combined
power- and ground-plane resistances), located in cell E5,
is used for the simplifying assumption.
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Adding radio buttons to select copper thickness
The copper thicknesses of ½, 1, 2, and 3 oz are arranged as
shown in Figure 8 to allow for the convenient use of radio
buttons to select them. To place a radio button, turn on the
Control Toolbox toolbar (View > Toolbars > Control

Toolbox) and select Design Mode and Option Button

(Figure 9a). In this mode, use the cursor to draw a box over
cells B3 and C3 as shown in Figure 9b. Right-clicking in the
new OptionButton1 area and selecting Properties makes
the dialog box in Figure 9c appear. Change the Caption

field from “OptionButton1” to “1/2 oz” and enter “B3” into

Figure 9. Adding radio buttons to select copper thickness

(b) (c)

the LinkedCell field, then close the dialog box. The radio
button now appears as shown in Figure 9d. With these set-
tings, cell B3 will be true when this radio button is selected.

Repeat the process for 1, 2, and 3 oz, linking their radio
buttons to cells B4, B5, and B6, respectively. The results
appear as shown in Figure 9e.

Because the GroupName field (Sheet1) is common to
all the radio buttons, only one thickness may be selected
at a time. The radio buttons will not work until the design
mode is exited, but there is one more task to complete
before exiting.

(a)

(d) (e)

Design Mode Option Button
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Adding a command button for recalculation
While design mode is still active, it is advantageous to 
create a reminder button to initiate recalculation. Select
the Command Button on the Control Toolbox toolbar
(see Figure 10a), then click on some empty cells and drag
to create a CommandButton1 box as shown in Figure 10b.
Right-clicking on the CommandButton1 box and selecting
Properties makes the dialog box in Figure 10c appear.
Change the Caption field from “CommandButton1” to
“Recalculate” and close the dialog box. Now a Recalculate

button is displayed as shown in Figure 10d. Exit design

mode the same way you entered, by clicking the Design

Mode button on the Control Toolbox toolbar (Figure 10e).
To cause the Recalculate button to force a recalculation,

a simple macro must be assigned to the button. Select
Tools > Macro > Visual Basic Editor to open Visual
Basic, then select View > Code to open a window similar
to the one shown in Figure 10f. Type in the code shown in
Figure 10g and close the window. Now, as the copper
thickness and temperature are changed, clicking the
Recalculate button will update the ohms-per-square values
appropriately (see Figure 10h).

Figure 10. Adding a command button for recalculation

(b) (c)

(a)

(d)

(e) (f)

(g) (h)

Command Button

Design Mode “Off”

http://www.ti.com/aaj


Texas Instruments IncorporatedGeneral Interest

36

Analog Applications JournalHigh-Performance Analog Products www.ti.com/aaj 2Q 2007

Building the node-voltage model
To build the node-voltage model, an equation for each
node must be entered into the appropriate cell in Excel.
Note that for each node, “adjoining cells” refers to those
found either above, below, left, or right—not at a diagonal.

Corner nodes: Enter the Excel expression for Equation 12,
“=(Sum of the 2 adjoining cells)/2”.

Example: For cell B13, enter “=(B14+C13)/2”.

Edge nodes: Enter the Excel expression for Equation 8,
“=(Sum of the 3 adjoining cells)/3”.

Example: For cell F32, enter “=(F31+E32+G32)/3”.

Central nodes: Enter the Excel expression for Equation 4,
“=(Sum of the 4 adjoining cells)/4”.

Example: For cell K23, enter “=(K24+J23+K22+L23)/4”.

Fill in all cells with the equations as described and click
the Recalculate macro button. All voltages remain at 1 V,
as there are no sources or loads. It is advisable to save the
spreadsheet at this point and to create a backup. New form
factors may easily be constructed at this stage by recopying
the equations in the desired resolution and form factor.

Adding sources to the model
Sources represent the output of the power supply at the
point of regulation. Positioning a source is easily done by
placing a fixed numeric value in the cell that corresponds
(geometrically) to the location of the actual power-supply
output on the PCB. It is convenient to give the cell a con-
trasting color for ease of identification. Figure 11 shows a

1-V source that was placed in cell D30 by simply entering
“1” in place of the equation.

Adding loads to the model
Loads represent current sinks geometrically located on
the PCB. Enter a location for a load current in cell H5 
and enter “10” in that cell (see Figure 12). Then type the
Excel expression for Equation 16 into cell M17 as
“=(M18+L17+M16+N17-$E$5*$H$5)/4”.

“$E$5” and “$H$5” are absolute (versus relative) refer-
ences to the copper resistance and load current, respec-
tively, and will not change as this equation is copied into
other cells. The remaining factors should change as the
load equation is copied into other cells.

Figure 11. Model with 1-V source entered in cell D30

Figure 12. Model with load current of 10
added in cell H5
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Putting it all together
For the load equation just described, the sheet resistance
(actually two times the sheet resistance to account for the
return path) is in cell E5, and the load current is in cell
H5. Set the temperature to 25°C and select 3-oz copper,
then click the Recalculate button. When the iterations are
complete, the screen appears as shown in Figure 13. Each
cell now contains the calculated voltage on the PCB (differ-
ential voltage to ground at the load point) for the given
copper thickness, source voltage, temperature, and load
current. The cells model voltages at the corresponding
geometric locations on the PCB.

For a visual representation of voltage distribution using
lightweight copper, change the copper thickness to ½ oz
and the temperature to 65°C and click Recalculate.
Selecting the voltage results and applying a surface chart
creates the voltage map shown in Figure 14.

Figure 13. Voltage distribution calculations using 3-oz copper
at 25°C with 1 source and 1 load 
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Figure 14. Voltage map of recalculated data
with ½-oz copper at 65°C
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To see an example with multiple loads, reset the copper
thickness to 1 oz, the load current to 5 A, and the ambient
temperature to 65°C. Then copy the load equation in cell
M17 into 9 additional locations on the PCB and click
Recalculate. The results are shown in Figure 15a. Figure
15b shows the new voltage gradient.
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Figure 15. Calculated voltage distribution with 1 source and 10 loads

(a) With 1-oz copper

(b) With 1-oz copper (c) With 3-oz copper
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The 50-A total load with 1-oz copper planes causes a
worst-case droop of 136 mV—much more than the typical
requirement of ±30 mV—and that doesn’t include transient
response. Obviously, thicker copper planes are required,
so the copper thickness should be adjusted back to 3 oz
(Figure 15c). In this case, the maximum droop is 23.4 mV—
a much better situation.
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The voltage-gradient information provided by the model
is very helpful in determining the optimal placement of
the remote sense lines relative to the power supply or
power module.

Adding slots or vias
Slots or rows of vias may be modeled by inserting edge
and corner nodes into the appropriate locations in the
worksheet and placing a “0” in the cells that represent the

slots (Figure 16a). With the slots included in the calcula-
tion, the voltage plot looks as shown in Figure 16b. The
slot changes the worst-case voltage droop to 30.3 mV.

Many situations may be modeled with this simple exam-
ple. Additional accuracy is expected as more cells are used
to model the sheet resistance. The maximum number of
columns in Excel is limited to 256, which sets the limita-
tion for the minimum resolution (for one dimension of the
PCB). Note that the three-dimensional graphing capability

Figure 16. Model with slots added
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of Excel is limited to about 25 cells, so graphs are not
available for higher resolutions. However, this is not a 
serious limitation, since the cell values are displayed in the
table. Simple conditional formatting may be used to color-
code the results directly on the spreadsheet without the
need for a separate graph.

Further applications
The technique described may be used to construct more
complicated geometries. In general, plane thicknesses are
not always the same, as ground planes are typically thicker
than power planes. Further, power planes may be split
rather than uniform, or the “power plane” may be simply a
very wide trace on a signal layer. With the described tech-
nique, a model for each plane may be constructed and a
“difference” sheet created to examine the voltage differ-
ence at different load points. Separate temperature and
resistance sheets can also aid in constructing more com-
plicated geometries.

One common concern is the voltage drop that occurs
due to the “Swiss-cheese” effect of having many vias 
located in and around high-density ICs. This problem 
may be addressed by inclusion of the nonuniform resistive
effects described in Equations 3, 7, 11, and 15 in the
spreadsheet model. Model the resistance of the square by
taking the ratio of the copper area to the “empty” area
(where vias occur) and increasing the resistance for that
square by the ratio.

Including local temperature effects
The copper resistance is a function of temperature, as
noted previously. Localized heating due to FPGAs or DSPs
will increase the temperature and thus the resistance of
the copper around the load points. This variable may be
included in models by creating an expected temperature
map of the PCB and adjusting the effective resistance for
each square according to the local temperature on the
board. Again, this requires the inclusion of the nonuniform
resistance equations.

Conclusion
The voltage drop of PCB power and ground planes can 
be a significant contributor to the total voltage-tolerance
budget for processor cores. Excel and other spreadsheet
software with circular reference /iteration capabilities may
be used to construct a model of the PCB that can greatly
assist the designer in selecting copper thickness and remote
sensing locations, proportioning the voltage-tolerance bud-
get, and optimizing the bypass capacitance necessary to
meet transient requirements. The spreadsheet results also
provide guidance for power-supply and processor placement.

Related Web sites
dsp.ti.com

www.ti.com/sc/device/TPS40140

A copy of the finished spreadsheet is available for down-
load at: www.ti.com/lit/zip/slyt274

http://www.ti.com/aaj
http://www.ti.com/sc/device/TPS40140
http://www.ti.com/lit/zip/slyt274
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